
Download from Www.Somanuals.com. All Manuals Search And Download.



Important Note, Please Read:

CoPilot Help Files on your Pocket PC

Do not use this product in any way that interferes with safe and attentive 
operation of a vehicle. The driver must remain alert at all times to actual road
conditions and obey all posted signs and traffic regulations. Always keep
your hands on the steering wheel and eyes on the road when driving!
While driving, either ask a passenger to operate CoPilot or pull over to the
side of the road when interacting with CoPilot on your Pocket PC.

Now CoPilot Live includes Help files on your Pocket PC to assist you. After
launching CoPilot, tap Tools at the bottom of the screen and tap Help.

1.  Check the package contents
Your CoPilot Live package includes the following:

� Install/Data Disks
� Quick Start Guide
� GPS Receiver (not in software-only packages)
� In-Vehicle Power Adapter (not in software-only packages)
� Vent Mount (not in software-only packages)

2.  Uninstall any previous version
If you have a previous version of CoPilot installed on your Pocket PC and/or
desktop computer, you must uninstall it before updating. Make sure your
GPS receiver is NOT attached, then follow these steps:

(1) On your Pocket PC:

1. Tap the Start menu and select Settings/System/Remove Programs
2. Select Pocket CoPilot and tap Remove.
3. Select Pocket Speech and tap Remove.
4a. If you stored map data on a storage card:

i. Delete the Pocket CoPilot folder on the storage card. Tap Start, then
Programs/File Explorer/My Device/SD Card, then tap and hold on Pocket
CoPilot and select Delete from the menu.

4b. If you stored map data on your device memory:
i. Delete the Pocket CoPilot folder on My Device. Tap Start, then

Programs/File Explorer/My Device, then tap and hold on Pocket CoPilot
and select Delete from the menu.

(2) On your Desktop/Laptop computer:

1. Select Start/Settings/Control Panel.
2. Double-click Add/Remove Programs.
3. Select Pocket CoPilot and click on the Remove button.
4. If asked to confirm the removal of Pocket CoPilot and all of its 

components, selectYES.
5. If asked to remove shared files during the uninstall process, select

No To All.
6. Select Start/Search/Files or Folders and find the Pocket CoPilot folder.
7. Right-click the Pocket CoPilot folder and select Delete.

NOTE: Make sure no previous version of CoPilot is installed (see above).

Your desktop/laptop and Pocket PC should both be turned on. The cradle/cable
for your mobile device must be connected to your desktop through either a USB
or Serial port. Your Pocket PC should be connected to your desktop via
ActiveSync. If it is not, see the instructions that came with your Pocket PC.

If you plan to use a Storage Card Reader, it must be installed and connected to
your desktop. You can also use a PCMCIA adapter for the Storage Card if you
have a laptop

3.  Install CoPilot Live
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Installation Steps:

Step 1: Insert the CoPilot Live Install Disk into your CD-ROM drive. Enter
your Product Key Code when prompted (you can find it on the
cover of your printed Quick Start). Click Next.

Step 2: Make sure Pocket PC Installation and Desktop Installation are
checked on the installation menu. Click Next.

Step 3: The installation will start with the text-to-speech software.
Choose a Male or Female Voice (both are standard TTS file), or 
Pre-recorded Sound Files (WAV files, male voice) when prompted.
The pre-recorded option saves space on your Pocket PC, but 
provides less detailed driving instructions. Click Next.

Step 4: Click Next if prompted to make an ActiveSync connection.
(You should already be connected. If not, cancel the installation,
make the connection and start over.)

Step 5: Choose an installation location on the Pocket PC. The default is the
device’s main memory (click Yes). Recommended: To install to a 
storage card, click No, then choose Storage card from the drop-
down pick list.

Step 6: When CoPilot has been installed to your Pocket PC (this will take a
few minutes), you will be prompted to begin the desktop/laptop 
installation. Click Next and follow the on-screen instructions.

Step 7: When the installation is complete, a CoPilot Live icon will appear on
your desktop.

NOTE to Navman GPS Jacket Users: If you are using this software with
the Navman GPS Jacket (the jacket will have the word NAVMAN molded into
the back of it and has a conical antenna), you must also install drivers for that
jacket separately:

1. Insert the CoPilot Live Install Disk into your CD-ROM drive.

2. Exit out of the Installation screen when it appears.

3. Open up My Computer, right-click on your CD-ROM drive and
select Explore from the pop-up menu.

4. Open the WinCE folder, then open the Legacy Drivers folder and
copy the file 3.1.1.COM.ALKNavman.arm.CAB to the My
Documents folder on your Pocket PC.

5. On your Pocket PC open File Explorer and go to My Device >
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My Documents and single-tap the CAB file you just copied from your
computer. This will install the appropriate drivers.

6. You may have to unseat/reseat your iPAQ in the jacket in order for the
drivers to take effect.

4.  Download map data

NOTE: CoPilot Live won’t open on your Pocket PC unless map data
has been downloaded first.

(1) Choose a Storage Location:

1. Open the CoPilot Live application on your desktop/laptop, then 
click the Data Download Wizard icon in the sidebar on the left.
Make sure your Pocket PC is synchronized.

2. Choose where you would like data stored on the Pocket PC.
CoPilot will scan your computer to detect which options are 
available. If you choose an option other than the device memory,
click the pick list that appears and select a storage card name or the
drive letter of your storage card reader. Click Next.

NOTE: If data is stored on the device's memory and also on a Storage Card
in the device, CoPilot will use the Storage Card by default. To have it use map
data on device memory, you must remove the Storage Card.

(2) Select a Data Area:

Select City Radius to create a data region of a specified radius 
around a city of your choice:

1. In the City, State or ZIP Code box, type a City, State (e.g. new york,
ny) and press <Enter>.

2. Specify the Distance Around City to Download (e.g. 60) and press
<Enter>. Click Next.

3. Your selected data region will be displayed. A window will appear
showing how much space you have available on your selected 
destination (see Choose a Storage Location above) and how much 
memory this data region will take up. If necessary, adjust the radius 
to make sure your data region will fit on your selected destination.
Click Next.

4. Give your data region a name and click Next.
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5. You will then be given the option to either select additional map
data or download selected areas to your Pocket PC. Click
Download.

(3) Download the Data:

1. Clicking the Download icon will take you to a screen where
Available Area(s) for download are displayed on the left.

2. To designate an area to include in the download, highlight it and then
click on the right arrow button to move it to the Data Included in This
Download list on the right. To take an area off the list, highlight it and
click the left arrow button.

3. After confirming that the area(s) you would like to download are in the
Data Included in This Download list, click Download to complete the
map data download process.

- v - - vi -

5.  Activate the Software

6.  In-vehicle hardware setup

7.  Adjust the speech volume

To hear CoPilot Live’s voice prompts, the volume on your Pocket PC must
be turned all the way up. In the Pocket PC Start menu, go to Settings and tap
on Sounds and Notifications. Under System Volume, move the slide bar all the
way to the right.

You can also use your Pocket PC’s keypad when CoPilot Live is open: tap up
until you reach the maximum volume.

NOTE: CoPilot won’t open unless map data has previously been 
downloaded from the CoPilot desktop application (see Step 4).

The first time you open CoPilot Live on your Pocket PC, you will be asked to
activate the software. CoPilot must be activated before you can use it.

To launch CoPilot Live, first turn on your Pocket PC and attach the GPS receiver.
Tap Start on your Pocket PC and choose CoPilot Live from the drop-down
menu.

The first time you open CoPilot Live on your Pocket PC, the Activate screen
will appear. For Automatic Activation, follow the on-screen instructions:

1. Synchronize your Pocket PC via ActiveSync to your laptop/desktop.

2. Connect your laptop/desktop to the Internet. Make sure it is active and
you are logged in if necessary.

3. Tap Next when ready.

To Activate Manually:

If you do not have access to the internet and would like to obtain your
Activation Code by phone, check Activate manually and tap Next to go to a
screen that displays your Product Key Code and License Number. Then call
ALK Technical Support at 888-872-8768 Monday-Friday, 9:00am-5:00pm EST.
You will be asked for your Product Key Code and License Number.

WARNING: Never leave GPS receiver in closed vehicle that exceeds 140o F.

First turn on your Pocket PC, then make sure that the GPS receiver is attached
and powered and your engine is running before using CoPilot Live.

If you have a CoPilot vent mount and in-vehicle power adapter:
1. Attach the cable to the Pocket PC and insert it into your vehicle’s 

cigarette lighter socket. Make sure it is firmly seated (red light on).
2. Attach the vent mount clips to the vent in your vehicle, in a position that

will allow you to be comfortable as you view and operate CoPilot.
3. Slide the Pocket PC into the vent mount, and make sure it is turned on.

Third Party GPS Receiver setup:
On your Pocket PC, select Options from CoPilot’s Tools menu. Then select
the GPS tab (bottom) and tap on Auto Scan. CoPilot will scan 
all COM Port and Baud Rate settings until it finds your GPS receiver.
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8.  Enter an address

9.  Start driving

Contact information and additional help

NOTE: There is no need to enter a starting point. CoPilot Live uses GPS 
positioning to determine your location automatically.

Start driving!  To toggle between the Driver Safety and the Passenger screens,
tap the Driver/Passenger button. The Driver Safety screen only shows maps
as you approach your next turn or when you’re traveling slower than 10 m.p.h.

For more detailed instructions and descriptions of CoPilot Live’s screens,
menus, and features, see the User’s Guide that came with the product or the
Help Files in either your desktop (Help menu > Help Contents and Search) or
Pocket (Tools menu > Help) installation.

Registered users can e-mail techsupport@alk.com or call 888-872-8768,
Monday-Friday, 9:00 am-5:00 pm EST for technical support. Please be at your
computer. Also check out our Internet site at http://www.alk.com/cp4 for
technical support documentation and posted answers to common questions.

1. The first time you use CoPilot Live, you will be asked to enter your
nearest city to help speed up the initial GPS acquisition. Enter your city, state
(e.g. new york, ny) and tap OK. You will only need to enter your nearest city
the first time you use CoPilot Live.

2. Tap the Address button
when asked to enter a 
destination.

3. Select a state from 
the drop-down menu.

4. Using the keyboard, type
in the name of a city.
Possible matches will be 
provided. Tap the <Enter>
key to select the city.

If this is not your first use of
CoPilot Live, a pick list of
cities previously entered may
appear.

5. In the Addr box, type 
a street address (optional). Then tap <Enter>.

If there is an exact match in CoPilot’s database, your address will appear on the
Address list highlighted in blue. Tap <Enter> again to confirm your 
destination. If no exact match was found, a list of possible matches appears.
Highlight one and tap <Enter>.

6. In the Edit Trip screen, tap the
View Route button to begin 
receiving guidance instructions to
the destination you entered. Or
enter additional stops first.

Driver/Passenger Button

Driver Safety Screen Passenger Screen

Step 2

Step 4 Step 5

Step 3
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CoPilot Overview
Your CoPilot Live | Pocket PC 4 Includes:

� Install/Data Disks

� GPS Receiver (not in software-only packages)

� In-Vehicle Power Adapter (not in software-only packages)

� Vent Mount (not in software-only packages)

Desktop PC Requirements

� Microsoft Windows 95, 98, 2000, ME, XP or Windows NT®

(4.0 or higher)

� Pentium II processor or better

� 12X CD-ROM or better

� 64 MB of RAM and a hard drive with at least 65 MB 
of available disk space  

� Microsoft ActiveSync version 3.1 or later

Pocket PC Requirements
With Map Data on Storage Card

� Pocket PC running Windows CE 3.x or Pocket PC 2002

� MIPS, SH3 or StrongARM processor

� 4-7 MB of storage RAM

� 6-12 MB of program RAM (available for running programs)

� Storage Card recommended 
(minimum 32MB, 64MB recommended)

GPS Requirements

� Standard NMEA GPS receiver* including:

� CF GPS receivers

� iPAQ GPS Jacket

� Cabled GPS receivers

� Wireless Bluetooth GPS receivers

* For information on purchasing a GPS receiver from
ALK  Technologies, go to www.alk.com.

A Safety Warning
Always keep your hands on the steering wheel and eyes on the road when
driving! 

Do not use this product in any way that interferes with safe and attentive operation
of a vehicle. When used in a vehicle, do not place the GPS receiver, antenna, power
supply, or your computer where it may strike the driver or passengers if the vehicle
turns sharply or stops abruptly. This product is designed, manufactured, and 
intended as an aid to planning and navigating routes. The accuracy of the map data,
driving directions, and GPS tracking system is insufficient for this product to be used
for automated navigation or in any situation in which the failure of the product
could lead directly to death, personal injury, or physical or environmental damage.
The driver must remain alert at all times to actual road conditions and obey all
posted signs and traffic regulations.

TravRoute assumes no responsibility for any damage or injury resulting
from the use of this product.

What’s New in Version 4.0?
Enhancements and new features in CoPilot Live | Pocket PC 4 that we think you’ll
like include:

� Customizable Navigation Display - Now you can customize your 
navigation screen to display the current road, crossroad, vehicle speed,
current time, elevation, and nearest town. ETA and distance to 
destination are always displayed and constantly updated. Plus a new
Regional POI Download Option lets you choose which types of points of
interest you want displayed along with the map data you download, and
gives you complete access to 5 million POIs nationwide!

� Faster GPS Acquisition - CoPilot Live now acquires a signal within 
seconds from the time you begin.

� Trip Transfer - Trip itineraries created on your desktop can now be
downloaded to your Pocket PC for later use.

� RV and Toll Avoidance Routing - Favor major roads and avoid sharp
turns and U-turns wherever possible using CoPilot’s new RV routing
option. Choose Toll Avoidance routing to minimize toll payments.

� Custom Place Importing -  This new feature enables you to import
your own sets of addresses and download them to the Pocket PC as 
Custom POIs.

� Downloadable Favorites - Now you can transfer all Favorites stored on
your desktop PC when downloading map data.

� Live Messaging and Real-time Tracking - Maintain two-way 
communication with a driver who’s using CoPilot Live and actually see
where he or she is currently located using your home PC!- 1 - - 2 -
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Getting Started - Hardware
Both your desktop/laptop and your Pocket PC must be turned on. The
cradle/cable for your mobile device must be connected to your desktop/laptop
computer through either the USB or Serial port.

If you plan to transfer the map data to your mobile device's main memory, or to
a Storage Card in the device, there are no more connections needed.

If you plan to transfer data to a Storage Card through a Storage Card Reader,
you must also have the reader installed and connected to your desktop/laptop.
You can also use a PCMCIA adapter for your Storage Card if you have a laptop.

- 3 -

Getting Started - Get Connected
In order to successfully transfer data from your desktop to your Pocket PC,
you must have Microsoft ActiveSync 3.1 (or later) installed. This software is 
necessary to connect the two machines and is provided by your Pocket PC 
manufacturer. If you did not receive this software with your mobile device,
contact the distributor immediately.

1. When connecting your Pocket 
PC, if you have not set up a 
partnership between your Pocket 
PC and your desktop, you will be 
prompted to do so. This is not 
required. If you choose not to set
up a partnership select Guest 

partnership, and 
you will be logged 
in as a Guest and 
ready to transfer 
data between
machines.

2. If you have set up a partnership
in the past, or choose to do so at 
this point, be sure to allow your 
Pocket PC to synchronize with 
your desktop/laptop prior to 
launching CoPilot Live.

NOTE: If your desktop/laptop computer 
does not seem to be recognizing the 
connection with your Pocket PC, select
Connection Settings... from the drop-
down File menu, and make sure you're 
connected using the appropriate Port.
Then click Get Connected... in the 
File menu and follow the on-screen 
instructions.

- 4 -
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Uninstalling a Previous Version
If you have been using an earlier version of Pocket CoPilot it will be necessary
for you to uninstall the application and its data before installing CoPilot Live.

NOTE: When uninstalling CoPilot, your GPS receiver cannot be
attached. Before uninstalling, you must disconnect the receiver and perform a
soft restart. Then follow the steps outlined below:

(1) On your Pocket PC:

1. From the Start menu, select Settings/System/Remove Programs.
2. Select Pocket CoPilot and tap Remove.
3. Select Pocket Speech and tap Remove.
4a. If you stored map data on a storage card:

i. Delete the Pocket CoPilot folder on the storage card. Tap Start,
then Programs/File Explorer/My Device/SD Card, then tap and
hold on Pocket CoPilot and select Delete from the menu.

4b. If you stored map data on your device memory:
i. Delete the Pocket CoPilot folder on My Device. Tap Start, then

Programs/File Explorer/My Device, then tap and hold on Pocket
CoPilot and select Delete from the menu.

(2) On your Desktop/Laptop computer:

1. From the Start menu, select Settings/Control Panel.
2. Double-click Add/Remove Programs.
3. Select Pocket CoPilot and click on the Remove button.
4. If asked to confirm the removal of Pocket CoPilot and all of its 

components, selectYES.
5. If asked to remove shared files during the uninstall, select No To All.
6. Select Start/Search/Files or Folders and search for the Pocket CoPilot folder.
7. Right-click the Pocket CoPilot folder and select Delete.

Installing CoPilot Live
NOTE: You must uninstall any previous version of Pocket CoPilot from
your desktop/laptop and Pocket PC before proceeding (see above).

To install CoPilot Live, first turn on your computer and set up your Pocket PC.
Do NOT attach the GPS receiver yet, the application should not be
installed with the GPS receiver attached. Your Pocket PC should be 
connected via ActiveSync, as described on p. 4.

The steps in the installation process are covered on the following pages.

To Install CoPilot Live:

3. Make sure there are check marks
next to Pocket PC Installation
and Desktop Installation.
(Your Pocket PC should be 
connected with the desktop/
laptop before doing this part of
the installation). Click Next.

2. After clicking Yes to accept the
License Agreement, enter your
Product Key Code when prompt-
ed, then click Next. The 
installation menu will appear.

1. Insert the CoPilot Live Install
Disk in your CD-ROM drive.
Have your Product Key Code
ready (you can find it on your 
printed Quick Start).

4. The Installation Wizard will then
start installing to your Pocket PC,
beginning with the text-to-speech
software that delivers CoPilot
Live’s spoken driving instructions.
You’ll be prompted to choose a
Male or Female Voice (both
are standard TTS files), or  
Pre-recorded Sound Files
(WAV files, male voice). Choosing

- 6 -- 5 -
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6. The installation to your Pocket PC will
take a few minutes. Check your Pocket
PC screen to determine when the 
installation is complete.

NOTE to Navman GPS Jacket Users: If you are using this software with the
Navman GPS Jacket (the jacket has the word NAVMAN molded into the back of it
and has a conical antenna), you must also install drivers for that jacket separately:

1. Insert the CoPilot Live Install Disk into your CD-ROM drive.

2. Exit out of the Installation screen when it appears.

3. Open up My Computer, right-click on your CD-ROM drive and select
Explore from the pop-up menu.

4. Open the WinCE folder, then open the Legacy Drivers folder and copy
the file 3.1.1.COM.ALKNavman.arm.CAB to the My Documents
folder on your Pocket PC.

5. On your Pocket PC open File Explorer and go to My Device > My
Documents and single-tap the CAB file you just copied from your 
computer. This will install the appropriate drivers.

6. You may have to unseat/reseat your iPAQ in the jacket in order for the 
drivers to take effect.

1. Insert the Install Disk into your CD-ROM drive, follow instructions.

2. Make sure ONLY Pocket PC Installation is checked, click Next, and
select the voice option you want. Click Next again.

3. Click Yes to reinstall Pocket Speech.

4. Click No to reinstall CoPilot Live.

5. Click Yes to install in the default directory if that’s where you originally
installed. If you installed CoPilot Live elsewhere, click No and choose the
appropriate location.

6. Tap OK on your Pocket PC to reinstall.

7. Tap Yes to All if prompted.

8. Click OK on your Desktop, then click Finish to complete the process.

9. When the installation is complete, a CoPilot Live
icon will appear on your desktop or laptop. You
are now ready to start using CoPilot!

8. As the desktop installation 
proceeds, you will be given the
choice to install the CoPilot US
Data to your hard drive. This is the
recommended option and requires
700 MB of available space. If you
choose None, you will need to
insert the CoPilot Live Data Disk
each time you download data to
your Pocket PC or use CoPilot Live
for trip planning on your desktop.

- 8 -

7. When CoPilot has been installed 
to your Pocket PC, you will be 
prompted to begin the desktop/ 
laptop installation. Click Next and
follow the on-screen instructions.

Changing the Voice Option at Any Time
To change the voice CoPilot Live uses from male to female or vice versa at any time
after installation, you must first delete CoPilot from your Pocket PC (see Uninstalling
a Previous Version, p. 5, for how to uninstall the application). Then re-install CoPilot
Live to your Pocket PC, choosing only the Pocket PC Installation, and when you
are prompted to choose a voice option, make your selection.

5. Next, you will be prompted to choose
an installation location on the Pocket
PC. The default location is the Pocket
PC main memory (click Yes). To install
to a storage card, click No, then
choose Storage card from the drop-
down pick list (recommended).

the pre-recorded option saves space
on your Pocket PC, but will give you
less detailed driving instructions. Click
Next to continue.

Download from Www.Somanuals.com. All Manuals Search And Download.



Data Download to Your Pocket PC
To use CoPilot Live on your Pocket PC, you first need to download map data
from your desktop or laptop computer to your Pocket device. You select the data
to download from one or more regions (“data areas”) that you specify in the
CoPilot Live application on your desktop. It’s a simple 4-step process.

Step 1: Specify Where Data Will Be Stored

To begin the data download process, open the CoPilot Live application on your
desktop/laptop, then click the Data Download Wizard icon or pick Data
Download Wizard from the File menu.

CoPilot Live gives you three options for downloading data:
1) directly to the Pocket device's memory,
2) to a Storage Card in the device, or 
3) to a Storage Card through a Storage Card Reader.

You will be prompted to enter one of these choices before you can download.
CoPilot will detect which options are available to you.

NOTE: If there is data stored on the device's memory and also on a
Storage Card in the device, CoPilot will use the map data on the
Storage Card by default. To have it use the device's memory, you must
remove the Storage Card.

- 10 -

1. To download to Pocket PC 
Device Memory:
(In this example, CoPilot Live has
detected that there is no Storage
Card in the device.)  Click Next
to go to the Data Selection window.
See CoPilot QuickStart, p. 10, for a
description of software included in
downloads. See p. 20 for Options.

2. To download to a Storage
Card in the device:
(In this example, CoPilot Live has
detected that all options are 
available.)  Select a storage card
name from the drop-down pick
list, then click Next to go to the
Data Selection window. See CoPilot
QuickStart, p. 10, for a description
of software included in downloads.
See p. 20 for Options.

- 9 -

3. To download to a Storage 
Card through a Card Reader:
(In this example, again all options 
are available.) Pick the drive letter
associated with your Storage Card
Reader, then click Next to go to
the Data Selection window. See
CoPilot QuickStart below for a
description of software included in
downloads. See p. 20 for Options.

NOTE: You can also download to a Storage Card through a PCMCIA
adapter. Simply identify the drive letter associated with the adapter under the
Storage Card Reader option.

CoPilot QuickStart
Storage Card Application Download

If you are downloading map data to a Storage Card or Storage Card
Reader, you have the option to download a complete, ready-to-use
“QuickStart” version of CoPilot Live along with the data. Having the
QuickStart version on your Storage Card ensures that CoPilot Live will
be available even if you experience technical problems with your Pocket
PC and need to perform a hard reset. (During a hard reset, all installed 
applications are deleted from the Pocket PC.)  Inserting a storage card
with the QuickStart version will automatically install CoPilot,
and your map data will already be there!

The QuickStart option can be turned on or off in the final step of the
download process (see p. 19). By default this option is active and
the QuickStart download will be executed each time you 
download map data.

The QuickStart needs 10 MB of space on your Storage Card. Once the
QuickStart has been copied, you can save time the next time you 
download data by unchecking the Create QuickStart option in the final
Data Download Wizard screen before proceeding to download. You will
also want to uncheck this option if you do not have enough room on your
Storage Card for it.

If the QuickStart is copied onto your Storage Card and you need to
remove it, simply delete the folder that contains it. The folder will be
named either “2577”, “4000”, or “10003” depending on which type of
Pocket PC you are using.
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Data Download
Step 2: Choose a Data Selection Method

After you specify a location where the data will be stored, you will be prompted
to select a region on the map to download. CoPilot allows you to download
data using one of the three methods described below.

See Data Download Step 3 beginning on page 13 for step-by-step instructions for
downloading data to your Pocket PC using each of these three methods.

City Radius -  This method allows you to quickly select data in the shape of a
circle surrounding any city in the United States. In the Data Download Wizard
you type a city name and state abbreviation or ZIP code and enter the number of

miles you would like the radius
to extend around the city, then
click Next.

The Wizard displays a map that
shows the city and the radius
you chose. At this point you
can zoom the map in and out
using zoom buttons and adjust
the size of the data area by
altering the radius of the circle.

Map Area -  This method of selecting data allows you to choose an area of data
by drawing a box on the Data Download Wizard's map screen.

In the Wizard, you enter a city
name near which you would like
to select data, then click Next.
The map will zoom to that 
location. Then you create a 
box around the desired area by
clicking and dragging your
mouse across the map. The
street-level data within that box
will be selected.

At this point you can zoom 
the map in and out using zoom
buttons and adjust the size of
the data area by redrawing
the box.

Trip -  The Trip method of selecting data is by far the most customizable method.
This option allows you to run a trip and select street-level data specific to that trip,

thereby avoiding unneeded data
and saving valuable memory
space.

Once the trip is run, the Data
Download Wizard automatically
selects circles of data around
your origin and destination,
and a corridor of data along
your route. You can then click
Options to adjust the radius of
the circles and the width of the
corridor.

The Trip Itinerary for each trip
you download will be stored on
your Pocket PC (see Trip
Transfer, p. 20). Multiple trips can
be downloaded to the Pocket
PC for later use.

- 11 - - 12 -

City Radius

Map Area

Trip
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Data Download
Step 3: Select Your Data

Use any of the three methods covered on the following pages (City Radius,
Map Area, or Trip) to select one or more regions and then download your data.

City Radius

- 14 -

Note: CoPilot’s available mem-
ory calculations subtract 15 MB
from the available memory on
your storage card (if you are
using one) to account for 
support files.

1. Click the City Radius icon.

4. Name the selection.
Click Next.

5. You will return to the Data 
Selection Menu where you can 
select another data area if you
like, using any method. When
you finish selecting data areas,
click the Download icon and
you will be taken to the final
screen where you can build
your download.

2. Enter a City, State or ZIP 
code, and a mile radius
around the area that you
would like to download. Click
Next to verify that the area is
correct.

3. Using the Data Download 
Wizard toolbar you can zoom
in or out, change the radius, or
go back to the previous screen.
When you are satisfied with
your selection, click Next.

- 13 -
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Map Area

- 15 - - 16 -

Note: CoPilot’s available 
memory calculations subtract
15 MB from the available 
memory on your storage card
(if you are using one) to
account for support files.

4. Name the selection.
Click Next.

2. Enter a City, State or ZIP 
code (address optional) within
the area that you would like to
download. Click Next.

5. You will return to the Data 
Selection Menu where you can 
select another data area if you
like, using any method. When
you are finished selecting data
areas, click the Download icon
to go to the final screen where
you can build your download.

3. Click and hold the left 
mouse button and drag the
cursor to draw a box around
a desired area. The size of the
area will be displayed in the
toolbar. Click Next.

1. Click the Map Area icon.
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Trip

- 17 - - 18 -

3. If you choose the Points of 
Interest tab, enter a City, State 
or a ZIP Code and click the
Find button.

You can specify search 
parameters by selecting a POI
Category and/or Type (this 
will speed up the search).

3a. Highlight a selection, click
Select, then Add Stop.
When all your stops have
been entered, click Select
Data.

4. By default a 20 mile radius 
around all stops and a width of 
4 miles along the corridor   
which connects them will be 
highlighted. Note: CoPilot’s
available memory calculations
subtract 15 MB from the avail-
able memory on your storage
card (If you are using one) to
account for support files.

5. To customize these 
distances for any trip, click
Options and type a distance
in the appropriate box.

6. You will return to the Data 
Selection Menu where you can 
select another data area if you
like, using any method. When
you are finished selecting data
areas, click Download. Trip
itineraries that were created
using the Trip download
method will be transferred
along with map data. See p. 20.

1. Click the Trip icon.

2. You now have three options for
entering stops on your trip. If
you choose the Cities and
Addresses tab you will need to
enter a City, State or ZIP
code, press <Enter>, and click
the Add Stop button.

You may enter one or multiple
destinations. Use the buttons
to the right of the Itinerary to
zoom to a stop on the map,
change the order of stops, or
delete a stop.
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Data Download
Step 4: Download the Data

When you’re ready to execute a download, the Wizard will display a list of
Available Area(s) for download on the left side of the window. To designate an
area to include in the download, click on it and then click on the right arrow
button to move it to the Data Included in This Download list.

Notice that the amount of available map memory and the memory required for
all the areas on the Included list is shown under the list. NOTE: CoPilot's 
available memory calculations subtract 15 MB from the available memory on 
your storage card (if you are using one) to account for support files.

If you need to move an area off the Included list, click on it and use the left
arrow button. To delete an area from memory, click on it and click Delete.

IMPORTANT: Each data download overwrites the data that is already
on your Pocket PC. If any data areas are already loaded on your Pocket PC,
they will be overwritten by the new download. Therefore, your download must
include all areas that you wish to have available on your Pocket PC.

Check Include US Highway Network to download CoPilot’s complete US
Highway Network along with your data. This additional download requires
approximately 36 MB of space on your Pocket PC. When this network is loaded,
major roads, cities, and some points of interest outside your selected data region
will be shown on the map and you’ll be able to receive guidance as you drive
anywhere in the United States.

Check Download Favorites to download your Favorites list from the Trip
Planner window on your desktop along with map data. These addresses will then
be available as Favorites for trip entry on the Pocket PC.

Uncheck Create QuickStart if you do not want the CoPilot QuickStart 
software copied to your Storage Card (see p. 10 for a description of this feature).

POI Download Options
When you download a data region, you’ll get all roads within that region (but not
roads outside the region). Also included with each download are regional points
of interest (POI) such as gas stations, hotels, restaurants, visitor attractions, etc.

CoPilot Live now lets you control the number and types of points of interest that
get downloaded along with your data areas. You can save space on your Pocket
PC by eliminating categories of POI that you’re not interested in seeing.

To select which POI categories you want, choose POI Download Options from the
Edit menu in the desktop application or, when you first open the Data
Download Wizard, click the Options button in the Wizard. In the window that
opens, check the categories you wish to select. Click the plus sign next to each
category to see the included sub-categories.

Click Save Settings to save the set of categories you create. Click Restore
Default to return to CoPilot’s default categories.

Trip Transfer
CoPilot Live now transfers whole trips to your Pocket PC when you use the Trip
option for data downloading. Any trip you create, including its Itinerary, is 
automatically downloaded along with the surrounding data corridor and will
become the current trip on your Pocket PC. A .TRP file is created and placed in
the Save directory in the CoPilot installation folder on the Pocket PC. Subsequent
downloads will add more .TRP files to this folder. The number of trips that may
be stored is limited only by the available memory on your Pocket PC.

If multiple trips are downloaded, the last one to be added will open as the current
trip. Use Open Trip in the pop-up Tools menu to open a stored .TRP file.

- 19 - - 20 -
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Importing Custom Places
CoPilot Live’s Custom Place Import Wizard enables you to import addresses from
your Outlook Contacts database, an Excel file, or text file. (If you are using
another type of database or contact manager, you can export your contacts/
locations to an Excel or text file before importing them into CoPilot Live.)
These points are added to CoPilot’s POI database under the Custom category.
Once they are in the database, they are displayed on maps as pushpins and 
included in search results when you search for points of interest on your Pocket
PC or in the Trip Planner window on your desktop/laptop.

To access the Wizard, choose Import Custom Places from the Tools menu in
Planning Mode on the desktop, then follow the step-by-step instructions given by
the Wizard.

Use the Data Import Status window to edit any addresses that were not accepted
during the importing process, then click Add to import the final list of addresses.

For more detailed instructions, refer to the CoPilot Live Help files on your 
desktop (Help Contents and Search in the Help menu).

- 21 -

EEddiittiinngg CCuussttoomm PPllaacceess iinn tthhee DDaattaabbaassee

After custom places have been added to the database, they can be edited at any
time. Select Manage Custom Places from the Tools menu, then highlight the 
custom place you wish to edit, click Edit, and make your changes. Click Apply
when finished.

NOTE: By default, addresses entered as Custom Places are assigned to the
Custom POI category. You can change this assignment at any time by selecting
another Category from the drop-down pick list as you edit.

- 22 -
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Software Activation
NOTE: CoPilot Live won’t open on your Pocket PC unless map data has been
previously downloaded from the CoPilot desktop application.

CoPilot Live must be activated after installation before you can use it. Follow
the steps below to obtain an Activation Code that will unlock the software:

1. The first time you open
CoPilot Live on your
Pocket PC, the Activate
screen will appear.
Follow the on-screen
instructions and tap
Next.

2. In the next screen,
enter your e-mail
address and tap Next.
Your Product Key Code
and License ID number
will be entered auto-
matically if your Pocket
PC is turned on and
synchronized with your
desktop or laptop 
computer and you have
an internet connection.

3. CoPilot Live will be
activated within a few
seconds. Tap Next to
begin using CoPilot.

Deactivation and License Update:

If you’re planning to uninstall CoPilot Live from one Pocket device and install the
same version on another device, you need to deactivate the software on the first
device before installing it again. To do this, open CoPilot on your Pocket PC, tap 
the Tools menu, then tap Update License. Then tap Deactivate in the License
Manager. Your Pocket PC must be synchronized for the deactivation process to take
effect. When you re-install CoPilot Live on another device, you will be asked to
activate it again.

Speech Volume
To hear CoPilot’s voice prompts, the volume on your Pocket PC must be turned all
the way up. In the Pocket PC Start menu, go to Settings and tap on Sounds and
Notifications. Under System Volume, move the slide bar all the way to the right. You
can also use your Pocket PC’s keypad when CoPilot is open: tap up until you reach
the maximum volume.
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To Activate Manually:

If you do not have access to the internet
and would like to obtain your Activation
Code by phone, check Activate manually
and tap Next to go to a screen that dis-
plays your Product Key Code and License
Number. Then call ALK Technical Support
at 888-872-8768 Monday-Friday, 9:00am-
5:00pm EST. You’ll be asked for your
Product Key Code and License ID. When
you’ve received your Activation Code, enter
it and tap Next to activate.
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Address Entry 
NOTE: There is no need to enter a starting point. CoPilot Live uses GPS 
positioning to determine your location automatically.

Using Your Pocket PC for Guidance
In CoPilot Live's Guidance Mode you will receive turn-by-turn route guidance
information as you travel. For your safety the Driver Safety screen will hide maps
when they are not necessary to avoid distractions. Using the Passenger screen the
map will be visible at all times.
REMINDER: CoPilot Live won’t open on your Pocket PC unless map data has
been previously downloaded from the CoPilot desktop application.
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1. To launch the CoPilot Live program,
tap Start and choose “CoPilot Live”
from the drop-down menu. Because 
you have the GPS receiver attached and 
powered, CoPilot assumes that you are 
on the road ready to drive, and opens in
Guidance Mode to get you on your way
quickly and easily.

2. The first time you use CoPilot Live,
you will be asked to enter your current 
location to help speed up the initial GPS 
acquisition. Enter your city, state 
(e.g. new york, ny) and tap OK.

PLEASE NOTE: You will only
need to enter your initial city the
first time you use CoPilot Live.
For subsequent uses, CoPilot will
remember your last location 
automatically.

3. CoPilot will then provide you with a
number of different ways to enter an
address. You can:

a) Program your Home address
b) Program your Work address
c) Enter a new Address
d) Select a destination from your

Favorite List, or
e) Search for a Point of Interest

Tap the appropriate button to choose the 
option you would like to use.

Select a state from the
drop-down menu. Using
the keyboard, type in the
name of a city. Tap on the
city or tap the <Enter> key
to select it.

If this is not your first use of
CoPilot Live, a pick list of
cities previously entered may
appear.

Tap the 
Address 
button.

In the Addr box, type in the
street address (optional). Then
tap the <Enter> key. If there
is an exact match in CoPilot’s
database, your address will
appear on the Address list 
highlighted in blue. Tap
<Enter> again to enter it. If
no exact match was found, a list
of possible matches appears.
Highlight one and tap <Enter>.
Tap the Name box to enter a
name (optional), type in a name,
then tap OK.

In-vehicle Hardware Setup:

First turn on your Pocket PC, then make sure that the GPS receiver is attached
and powered and your engine is running before using CoPilot Live.

If you have a vent mount and in-vehicle power adapter:

1. Attach the cable to the Pocket PC and insert it into your vehicle’s cigarette
lighter socket. Make sure it is firmly seated (the red light should be on).

2. Attach the vent mount clips to the vent in your vehicle, in a position that will
allow you to be comfortable as you view and operate CoPilot.

3. Slide the Pocket PC into the vent mount, and make sure it is turned on.

Launch CoPilot Live:
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Once you enter a destination, CoPilot will
display the Edit Trip screen. At this point
you can enter additional stops using the
tool bar or begin receiving guidance to the
destination you entered by tapping the View
Route button (see below).

To add additional stops, tap one of the
trip entry buttons on the tool bar at the
top of the screen. Each option is described
on the following pages.

To begin your trip, simply tap the
View Route button and start driving!

To return to the Edit Trip screen from the navigation screen at any
time, first tap anywhere above or to the side of the map to bring up the tool bar.
Then tap the Edit Trip button.

Start Driving!

Entering a Home Address

Tap the Home
button in the
Edit Trip screen.
The first time
you use this 
button, you will
be prompted to
enter your Home
Address.

Enter the City or ZIP
code and address. Tap
OK and it will be saved.

Now you can tap the Home
button to enter your home
as a stop. To change your
home address, see Favorites 
p. 30.

- 28 -

Tap the View Route button
to switch from any screen to
start navigating.

Start driving and enjoy CoPilot’s spoken instructions, continuously updated maps
and ETA’s, and automatic route recalculation capabilities.

Distance to
Next Turn

Next Turn
Instruction

Driver/Passenger
Toggle

GPS Status

Messaging

Traffic
Incidence

ETA and Distance
to Next Stop

Current Road
(customizable) 

Crossroad
(customizable) 

View Route
button

Edit Trip
button
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Entering a Work Address

Finding Points of Interest
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Tap the
Work button.
The first time
you use this
button, you’ll 
be prompted 
to enter your
Work Address.

Enter the City or ZIP code,
Address, and (optionally)
Name of your workplace.
Tap OK to save it.

In later uses tapping the
Work button will enter your
workplace as a stop. To
change your work address in
the future, see Favorites p. 30.

Favorites

Highlight a Favorite and tap Edit to edit the address or name of the Favorite. To
change which Favorite is assigned to the Home or Work buttons, tap the Tools
menu, select Options, and tap on the Favorites tab. Highlight the one you wish to
change and tap either Home, Work, or Favorite.

NOTE: When your Favorites list is filled (50), each new address will
replace the address that has been inactive for the longest period of
time.

To Save Your Current Location As a Favorite:

You must be receiving GPS data to save your current location as a favorite.
Tap the GPS menu and then select Save Current Location.

Closing CoPilot
To exit the CoPilot Live application, select Exit from the pop-up Tools menu at the
bottom of the screen. (If the menu isn’t visible, tap the screen anywhere except
on the map.)

- 30 -

A prompt will ask you to assign
a location name to your current
latitude/longitude position. After
you enter a name, your current
location will be saved in the
Favorites list.

Tap the Favorites button.
A drop-down list will appear,
providing quick access to the
last 50 destinations that you 
entered.

Tap the Points
of Interest 
button to search
for and/or enter 
a point of interest
as a destination.

Select a state from the
drop-down menu, enter a
City, and choose a Type
from the drop-down menu.
Tap Find to execute the
search.

Select from the pick list
of nearby POIs that best
match your description by
tapping with your stylus.
Your choice will then be
entered as a destination.
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3.  Guidance
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Changing Views:

Map/Itinerary/Guidance Toggle 

NOTE: It is not safe to attempt to alter settings on your Pocket PC
while you are driving. Either have a passenger make changes, or pull
over to a safe area.

1.  Map

2.  Itinerary

In Guidance Mode you will receive turn-by-turn driving instructions. You can
change between the Driver Safety and Passenger screens by tapping this button in
the lower right hand corner:

The Driver Safety screen will only show maps as you approach your next turn or
when you’re traveling slower than 10 m.p.h. The Passenger screen will always
show the map. Please keep your eyes on the road if you are the driver!

Customizing the Guidance Screens
The two lines above the ETA in the Driver Safety
screen can be customized. Tap either icon to cycle
between displaying the current road, nearest cross-
road, speed, current time, elevation, or nearest town.

Both lines offer the same display options. Note that only one line will be shown
when the Passenger screen is displayed.

The map display can also be customized. Choose
Options in the pop-up Tools menu, then select miles or
kilometers for distances; a North Up map view that always
considers north to be at the top or Heading Up view
that always tracks your route upward; and Box Zoom
(draw a box around the area to zoom to with the 
stylus) or Drag Map (use the stylus to drag map to the
desired area).

Tap the View Map button to
switch from any screen to see a
map of your current location.

Tap the View 
Route button to 
go to the Guidance
screen.

To go to the Itinerary screen,
tap the View Itinerary 
button.

In this window you can view turn-by-
turn instructions to your next stop.

In the Map screen you will see the area 
around your current location. You can
Zoom In or Zoom Out and alter the map's
Detail level using the toolbar buttons.
Tap on an exit ramp on the map and
the exit number will pop up (where 
available).

DDrriivveerr SSaaffeettyy SSccrreeeenn PPaasssseennggeerr SSccrreeeenn
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Trip Editing and Waypoints
To get to the Edit Trip screen from the Guidance screens at any time, tap the
screen anywhere except on the map to display the tool bar, then tap the Edit
Trip button. From here you can edit the current trip or add additional stops.

Now you can tap and hold on any stop to activate a pop-up menu that lets you
delete, map or change the order of stops on your route. This menu also
lets you designate a stop as a “waypoint” (tap Set as Waypoint). Waypoints are
not considered as stops in the Trip Itinerary, their purpose is to guide CoPilot’s
route calculations along roads that you choose. To change a waypoint back to a
stop, choose Set as Stop from the menu. Waypoints appear with “>>” instead
of a stop number on the Going To list.

Also, CoPilot ignores waypoints when calculating the ETA and distance to the
next stop, so waypoints can be used to get the ETA and distance to a stop that is
not your next stop (see Getting ETA’s and Distances below).

Getting ETA’s and Distances

The estimated time of arrival (ETA) and 
distance to your next stop will always
be shown in the lower left corner of the
Guidance screens. After entering a destination,
tap the View Route button to display the 
Guidance screens and see the ETA/distance.

If your trip has multiple stops and you want to
know the ETA for a destination that is not the 
next stop, designate the stops between your 
current location and the target stop as 
waypoints as described in Trip Editing and
Waypoints above.

Contact Integration
CoPilot Live allows you to link directly to Pocket Outlook to retrieve address
information. With just a couple of quick taps of the stylus, you can enter a 
contact’s home and/or work address as your destination.
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1. From the Edit
Trip screen, tap
the Address 
button.

Address
button.

Edit Trip
button.

4. Make sure that CoPilot has
found the exact address. Tap 
on the address, or tap OK to
confirm.

5. Your contact’s address will
now be entered as a destination.
Tap the View Route button
and begin driving.

2. To pull a contact’s
address directly from
Pocket Outlook, tap
the Contacts button.

3. You can either scroll 
through your entire list
of contacts, or enter
the first few letters of
the contact you are
looking for. Choose
either the Home or Work
address.
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Picking Stops From the Map
CoPilot Live enables you to pick a stop off the map when you don’t know the
exact address of your destination. You must be in Planning mode to pick a stop
and name it (choose Planning from the Mode menu). The stop you pick and
name becomes a Favorite, which you can then enter as a destination in any mode.

Detour Feature
CoPilot Live’s Detour Feature allows you to preview an alternate route before
deciding whether or not to take it. Perfect for situations in which traffic has 
suddenly slowed ahead of you, the Detour Feature will generate an alternate
route and tell you exactly how much distance the new route will add to your
trip. You can then make an informed decision about whether you’re better off
driving through the delay or taking the new route.

1. Choose Planning from the
Mode menu at the bottom of the
screen.

2. In the Edit Trip screen, tap
either Going To or Origin to
identify your location as one or
the other, then click the Pick
Stops button.

1. As you approach a delay,
tap on the black screen
to make the toolbar appear.

2. Tap on the
Detour button to
request a new route.

3. CoPilot’s voice will 
tell you how many miles
the new route will add to
your trip, and will begin 
to give you new turn 
instructions.

4. If you decide to use
the new route, just keep
driving. Your old route
will be displayed in blue for
reference.

5. If you decide
not to use the
new route, tap 
the Cancel Detour
button.

6. CoPilot will then
return you to your 
original route.

3. In the Pick Stops screen, enter a
city name or postal code in which you
would like to search for a location. If
you know a nearby address you may
enter that as well.

4. Using your stylus, tap the area 
on the screen that you would like to
select. A short tap will display street
names. Tapping and holding will prompt
the selection screen.

5. In the screen that pops up,
the address of the area you tapped
will be displayed and you will be
prompted to name that address
for easy reference from your
Favorites list. - 35 - - 36 -
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Selective Routing
CoPilot Live allows you to be selective about the roads you take on your trip.
There are two ways to do this: 1) you can customize your Trip Itinerary in
Guidance mode so that CoPilot will avoid certain roads; or 2) you can guide
CoPilot’s route by entering stops as “waypoints”.

Avoiding a Road in the Trip Itinerary

Tailoring Your Route Using Waypoints

CoPilot Live lets you customize a route by designating some stops as 
“waypoints”. Waypoints appear on the Itinerary but they’re not treated like 
stops in Guidance Mode and or in routing instructions. You can enter a waypoint 
along a road you want CoPilot to use, and CoPilot will guide you through the
waypoint along that road toward your destination.

To designate a location as a waypoint, enter it as a stop in the Edit Trip screen.
Tap and hold the location on the Going To list until a menu pops up, then choose
Set as Waypoint. Waypoints appear on the Going To list preceded by “>>” instead
of a stop number. To turn the location into a stop again, repeat and choose Set as
Stop. You can set as many waypoints as you like on a trip; however, CoPilot will
always recognize the last address in the Going To list as a stop.

3. Tap the Avoid button,
and CoPilot will calculate a
new route that avoids that
road. You can customize
your trip only once.

1. Switch to the Itinerary screen by tapping on the 
View Itinerary button. The Itinerary screen provides a
list of all roads that you will be traveling on if you have
entered at least one destination. Once in the Itinerary
screen, you can edit your route using the Avoid button.

2. Highlight the road to avoid by tapping it 
once.

To Return to the Original Route:
You can return to the original route that CoPilot
gave you at any time by tapping the Return to
Original Route button.
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Tools Menu Options

Tap the Routing Tab
to change your Vehicle
Type, Routing Type, and
Routing Options. RV routes
favor major roads and
avoid sharp turns and U-
turns wherever possible.
Quickest routing is based
on the most practical
route in terms of road
quality, terrain, and
urban/rural classifications.

Tap the Guidance Tab
to adjust the turn warning
time and speech volume,
and to display or hide GPS
tracking on the map.
Note on Speech: See
Speech Volume, p. 24, for
additional ways to adjust
the volume.

Tap the GPS Tab to see
the speed at which your
GPS tracks will be played
back. From this screen
you can tap the Delete
GPS Tracks button to
remove your saved GPS
tracks. AutoScan will scan
your Pocket device for
any connected GPS
receivers.

Select Options from the pop-up Tools 
menu to jump to a screen that lets you
change various CoPilot Live application
settings and edit your Home or Work
address.
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POI Alert Options

Tap the Favorites Tab to open the list of your
Favorite Addresses. You can change the assignment
of your Work or Home address as well as Edit
and Delete One or Delete All addresses.

NOTE: When your favorites list is filled
(50), each new address will replace the
address that has been inactive for the
longest period of time.

Tap the Map Tab to
choose between Miles and
Kilometers, and a map display
that always tracks your 
position moving upward or
maintains north at the top.
You can also choose Drag
Map mode that lets you use
the stylus to drag the map in
any direction to a desired
location (versus drawing a
box around an area).

From the Tools menu, select Live and then tap on POIs to set POI reporting
options. When POI Alerts are enabled, CoPilot will alert you to the presence of
points of interest as you approach them. You can set how far away you’ll be
when you receive the alerts and which types of POIs should be reported. You
can also limit alerts to POIs right on your route, or include POIs that are nearby.

- 39 -

Modes
CoPilot Live has four modes of operation on the Pocket PC. Tap the pop-up
Mode menu at the bottom of the screen to select Guidance, Navigating,Walking,
or Planning Mode.

Guidance Mode

In Guidance Mode, you enter
one or more destinations, tap
the View Route button on the
toolbar, and start driving.
This mode provides you with
on-screen spoken driving 
directions and other information
relevant to your trip, such as
estimated time of arrival and
distance to the next stop.
To receive driving directions and
other data, you must have a GPS receiver attached to your Pocket PC and the
receiver must be in a good position to receive signals.

Navigating Mode

While in Navigating Mode, CoPilot will track your position as you drive. Unlike in
Guidance Mode, you won’t receive turn instructions or voice prompts. This
tracking feature is an ideal way to see your location on the map if you don’t want
to be distracted by CoPilot’s guidance features.

Walking Mode

Take CoPilot with you wherever you go! Walking Mode provides an as-the-crow-
flies distance and direction line to your destination, directions that are perfect for
walking. A GPS receiver must be attached and receiving signals.

Planning Mode

Planning Mode lets you use your Pocket PC as a pre-trip planning tool or easy-to-
use reference guide. Planning Mode lets you view static maps and directions 
without the need for a GPS receiver. Trip itineraries you create in Planning Mode
can be saved and then loaded in any mode at a later time.
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The GPS Menu
Status

Receiving signals-ON     Receiving signals-OFF      

To view your GPS satellite
activity at any time, select
Status from the GPS menu.

Here you will receive
information on Speed, Lat/
Long position, Heading, and
Time and Date. Tap on
the Sats tab for more
GPS satellite information.

From this window you
can get additional 
satellite acquisition
information. To get a 
3-D fix (required for
CoPilot to locate your
position) you must have
four satellites “in the
green” for several 
seconds.

Select Receiving from the
pop-up GPS menu to activate
or deactivate GPS satellite
reception. Receiving is active
if you see a check mark.

Tap once to change the status.
If Receiving is inactive, CoPilot
will be unable to provide driving
instructions.
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Open and Play GPS Tracks

1. To open a GPS track,
receiving must be turned off.
Select Open Tracks to open a
Windows folder of your stored 
.gps files.

2. To access a track, tap
once.

3. Select Play GPS
Tracks from the pop-up
GPS menu to begin track
playback.

4. During track playback you
can select Pause GPS
Tracks to stop the track from
playing.
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Save Current Location

You can use the GPS menu to save your current location as a favorite place. You
must be receiving GPS data to do this. Tap the GPS menu and then select Save
Current Location.

A prompt will ask you to assign a location name to your current latitude/
longitude position. After you enter a name, your current location will be saved
in the Favorites list.

NOTE: Remember that when your
favorites list is filled (50), each new
address will replace the address that
has been inactive for the longest 
period of time.

4a. Playback can be viewed in any
window. To control the speed,
select Options from the Tools
menu, tap the GPS tab, and use the
sliding bar.

5. Select Close GPS Tracks
from the GPS menu to stop the
track from playing. To turn 
receiving on, tap Receiving.
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Reference: CoPilot Live Screens
What's What on Your Pocket PC

The following is a guide to the various features and shortcuts available from the
screens you will see on your Pocket PC as you operate CoPilot Live.

Edit Trip Screen

Guidance (Passenger Screen)
Map will always be shown.

Shortcuts to: Home, Work, Favorites,
Address Input, Points of Interest, and the 
View Route button.

Numbers identify each stop. The last 
number is your destination.

Map shows area around your next stop.

Scroll to view more of the map.

If toolbar is not visible tap anywhere
outside the map.

Next turn instruction.

Next turn arrow.

Route ahead highlighted on the map.

Customizable data display, tap icon to cycle
between current road, crossroad, speed,
current time, elevation, and nearest town.

Toggle between Driver Safety and Passenger
screens.

GPS Status, Messaging, and Traffic indicators.

ETA and Distance to Next Stop display.
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Guidance (Driver Safety Screen)
Map will only be shown as you approach turn.

No GPS Signal 

If toolbar is not visible tap anywhere
on the screen.

Next turn instruction.

Next turn arrow and distance to next turn.

Customizable display, tap to cycle between
current road, crossroad, speed, current
time, elevation, and nearest town.

ETA and Distance to Next Stop display.

Toggle between Driver Safety and Passenger
screens.

GPS Status, Messaging, and Traffic indicators.

When you see this screen it means that 
CoPilot is not receiving data from the GPS
unit.

1) Check that all your connections have 
been made correctly, and that all wires are
secure.

2) Make sure your receiver is plugged into
your vehicle's power source.

3) In the drop-down GPS menu on your 
Pocket PC, be sure Receiving is checked.

4) Occasionally, when using the GPS
expansion pack without a power adapter,
this message may be displayed because 
the expansion pack is powering down 
temporarily to save power. Reception will
resume within a few seconds.
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Map Screen

Itinerary Window

Toolbar for easy access to Trip window,
Itinerary, and Zoom In/Out or More/Less 
Detail.

Direction which your map is facing.

Area around current location

Scroll map.

Scale of Miles.

Exit numbers: Tap any exit ramp on 
the map to see the exit number 
where available.

Toolbar for easy access to Guidance
screens, can also be used to avoid roads.

Distance between turns.

Direction of turns along your route.

Names of roads for upcoming turns.
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Address Input Screen

Points of Interest Search

Tap the Contacts button to select 
an address from Pocket Outlook.

Enter a City/ZIP code for your 
destination by typing it in using the 
keyboard at the bottom of the screen.
Previously entered cities can be chosen
from the drop-down list. Tap the 
Enter key or OK.

(Optional) Type a street address,
then tap the Enter key.

(Optional) Type a Name, then tap OK.

List of possible matches. Highlight one,
then tap the Enter key.

Enter key.

Enter a City/ZIP code from which
you would like CoPilot to search.

Select a category Type from the 
drop-down menu, and tap Find.

(Optional) Type a name to speed up
the search.

List of nearest matches to your search 
criteria (within the area downloaded to
your Pocket PC), and distance from the
city you entered. Highlight one and tap
the Enter key.

Enter key.
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Trip Planning on Your Pocket PC
You can use Pocket CoPilot on your Pocket PC for trip planning whether or not
the GPS receiver is connected and receiving data. Planning mode allows you to
run a trip on your Pocket PC even when you're not in your car. You'll get driving
directions and maps that you can use for reference before your trip begins.

1. First turn on your Pocket PC.
To launch the CoPilot Live 
program, click on Start and
choose “CoPilot Live” from
the drop-down menu.

2. Select Edit Trip, then tap the
Mode pop-up menu at the
bottom of the Edit Trip screen
and select Planning.

3. You’ll see the same trip entry
toolbar buttons as in the Edit Trip
screen, plus a Pick Stops button. Tap
the Origin bar to enter an origin
and the Going To bar to enter your
destination and any stops. See p. 35
on picking stops from the map.

4. Click the View Route button
and your route will be displayed in
the Map screen. You can Zoom
in/out and alter Detail levels using
the toolbar buttons.
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Trip Planning on Your Desktop

On the following pages you will find brief descriptions of the trip planning 
capabilities of the CoPilot Live desktop application. You can use CoPilot's 
desktop functions to map out routes and print maps and driving directions before
getting on the road. This is an additional feature of CoPilot Live that is in no
way connected to using your Pocket PC for route guidance.

To access Planning mode on your desktop/laptop, click the Planning icon in the
sidebar to the left of the map.

To see CoPilot’s desktop trip planning functionality described in more detail, open
the CoPilot Live Help Files from within the desktop application (Help Contents
and Search in the Help menu or click the Help button on the toolbar). Go to
Desktop Trip Planning in the Contents tab.

Menus and Toolbar Buttons

Using the drop-down menus you can select from a number of functions. Many of
these functions also have corresponding toolbar buttons:

1.  Open Trip
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5. Tap the Itinerary button 
to see the itinerary for your
planned trip.

6. Tap the Map View button
to return to the map screen.

Open Trip button or Open
Trip...from the File menu.

Takes you into a standard Windows folder
where you can select from trips you have
saved after running them in the Trip Planner.

Saving and Loading Trip Itineraries
To save a trip itinerary you put together, select Save Trip As from the pop-up Tools menu.
Give the trip a name and tap OK. The itinerary can then be opened at a later time in
any mode.
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2.  Save Trip

3.  Edit Trip

4.  New Trip

5.  Run Trip
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Save Trip button or Save Trip.../
Save Trip As... from the File
menu.

New Trip button or New
Trip from the File menu.

Takes you to the Trip Planner window
where you can create a new trip, arrange
the order of stops on your route, add or
edit Favorites, and search for Points of
Interest. Click Run to receive driving
directions and a map.

Run Trip button or Run Trip
from the Trip menu.

Generates the route. Will show a detailed
Trip Summary, and display a map and driving
directions for the route that was run.

Takes you into a standard Windows folder
where you can name trips to be saved after
running them in the Trip Planner.

Edit Trip button or Edit Trip
from the Trip menu.

Takes you to the Trip Planner window where you
can edit stops on your existing trip, arrange the
order of your stops, add or edit Favorites, and
search for Points of Interest. Click Run to 
generate driving directions and a map, or use
your Contacts database to add stops to your trip.
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6.  Print

7.  Help

8.  Data Download Wizard

9.  Zoom Out 10.  Zoom In
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Print button or Print... from 
the File menu.

Data Download Wizard
button or Data Download
Wizard from the File menu.

Takes you to the first screen in the Data
Download Wizard where you can specify the
location where you want downloaded data to
reside on your Pocket PC.

Zoom Out/Zoom In buttons or Zoom Out/Zoom
In from the Map menu.

Each time you click on one of these buttons,
your view will be zoomed in or out by one
increment. The zoom level is shown in the title
bar of the map window.

Takes you to the standard Windows Print
menu to print the active window that contains
your map or driving directions. Activate one or
the other window by selecting from the drop-
down Window menu. Select Print TravPak...
from the File menu to print driving directions,
an overview map, and a zoomed map of each
stop.

Help button or Help Contents
and Search in the Help menu.

Opens the Help Files at the Table of Contents.
From here you can search for help by topic,
use the Index, or Search for a word or phrase.
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11.  Less Detail 12.  More Detail 15.  Pick Stops

16.  Preferences
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More/Less Detail buttons or Detail from the Map menu.

Clicking on these buttons once will change the level of
detail you see on the map by one increment.

Click the Pick Stops button to turn on Pick Stop mode and
enter a stop by picking it with the mouse from the map.

Once Pick Stops mode is enabled,
click on any point on the map to
select that location.

You can then choose to enter it
as a start place, a waypoint, or a
destination.

Select Preferences from the
drop-down Edit menu.

In this window you can change the
way you view your desktop maps and
various application settings.

13.  Zoom to Region

Zoom to US button or Zoom Region
from the Map menu. This function
allows you to zoom your map view 
to a specific region.

14.  Refresh Map

Refresh Map button or Refresh Map
from the Map menu. When scrolling 
through a map you may notice it takes 
a few seconds for all the data to catch 
up. This function will snap the entire 
screen to a new map.
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17.  Landmark Reporting

18.  Help Menu

Reference: Desktop Trip Planning

What's What on Your Desktop

CoPilot Live on your desktop includes many options, special features and 
shortcuts.The following is a guide to the main screens you will see as you use
your desktop/laptop computer for trip planning.

Map Window

Trip Planner Window (Cities & Addresses)
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Select Landmark Reporting from
the drop-down Trip menu.

In this window you can control how
many Landmarks CoPilot points out
when generating driving directions.

Use the drop-down Help menu to
access the CoPilot Help Files for
assistance with all aspects of the
software. In this menu you will also
find helpful travel links, a link to the
ALK Web site, and a link to the ALK
data corrections e-mail address. With
street-level data changing every day,
you may discover some errors.
Please drop us an email. With your
help we will be able to improve our 
map data with every update.

Menus and toolbar buttons
to access all of CoPilot's 
desktop features.

Click on a tab to frame any
stop on your route.

Map of area around your
destination. Move your 
cursor over a street to 
view its name.

Distance Scale.

Direction the map is facing.

Select tab for address input.

Enter city name/state, or
postal code. Enter 
an address (optional), with
the option to add a Name
to it. Click the Add Stop
button to add the stop to
the Itinerary.

Use icons to move stops up
or down on your Itinerary,
zoom to stop location on the
map, delete a stop, or add a 
favorite.

See p. 61 for Routing Options.
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Trip Planner Window
(Points of Interest)

Trip Planner Window (Favorites)
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Select Tab for Points of Interest.

Enter a city or postal code
in which you would like to 
search, a radius within which 
to search, choose a category
and type from the drop-down
menu, and click the binoculars
to search. You can also enter a
name to narrow down the search
in the POIs that start with
box.

You will be given a list of matches
to your search criteria.
Highlight your selection and
click Select. Click the Add
Stop button to add it to your
Itinerary.

Select Tab for Favorites.

Highlight a selection from 
your list of places by clicking 
on it. You can zoom to it on the
map, or Delete it from the list
using the buttons to the right.
Click the Add Stop button to
add a favorite to your Itinerary.

See p. 61 for Routing Options.

Trip Planner Window (Contacts)

Driving Directions and Map (Split Screen)

Enter a person’s first or last
name and hit <Enter>.
CoPilot will search your
Contacts database for matches.

Select the Contacts address
type (as defined in Outlook) to
get the appropriate address,
then click the Add Stop button
to add it to your Itinerary.

When you click Run in the Trip Planner window, your route will be calculated
and driving directions and a map will display. To print either one, click on it and
choose Print from the File menu. To print directions plus all map views, choose
TravPak Printing.

Atlas, Start, and End tabs will
zoom to the map view of
those places respectively.

Driving directions give you 
turn-by-turn instructions including
ramps and exits, and distance
and time between turns.
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Routing Options

Trip Summary 

Click the Options button in the
Trip Planner window to access
CoPilot routing options.

Auto Quickest is the default setting,
and provides the quickest routing
for automobiles based on 
practical considerations such as
road quality, terrain, and urban/
rural classifications. RV routing
favors major roads and avoids
sharp turns and U-turns where
possible.

Click Advanced to set general
road preferences.

Drag the sliding bars to the left
or right to avoid or favor each
road type.

Set the road speeds CoPilot uses
in its route calculations for each
type of road by either typing or
clicking the up and down arrows
under Rural and Urban for each
road type.

Select Run from the Trip Planner
window to run the trip you enter.
Your trip will be calculated based
on addresses specified.

Summary will show start, end, and 
number of stops in between.

Total distance and time for trip.

Click OK to view map and 
driving directions.
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CoPilot Live Communications
CoPilot Live now allows you to maintain two-way communication with drivers
who are using CoPilot and to actually see where they are currently located using
your home or office PC.

Using this CoPilot Live functionality requires the following:

1) CoPilot Live open on your home or office PC. Your PC must be 
connected to the internet.

2) CoPilot Live running in the vehicle. Your Pocket PC must have a wireless
internet connection. (Visit our website at www.alk.com/cp4 for a list of
recommended hardware configurations.) 

To begin using CoPilot Live functionality on your desktop, click the Live icon on
the sidebar to the left of the map. The upper portion of the new pane that opens
is the Vehicle List. Your connection to the CoPilot Live network is displayed
above the Vehicle List.

The login ID of the driver is displayed on the Vehicle List, with columns for the
vehicle's next stop, ETA, speed, location, and time of last update. To see all
columns, expand the pane by placing the cursor on the right edge until it
becomes an arrow and dragging.

Below the Vehicle List is the Message Center. The text of sent and received 
messages will appear here.

NOTE: All of CoPilot Live's communications are done in real-time. This means
information is only transferred when the driver in the vehicle and a user on a
home/office PC are using CoPilot Live at the same time. In this sense CoPilot
Live communication is similar to using a telephone - communication only occurs
when both parties are on at the same time.

ALK does not actively log a driver's location information, nor do we use this 
information for any purpose other than to transfer it to a home/office user.

Pocket PC Setup

Automatic Vehicle Location (AVL)
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Server Name

Vehicle List

Message
Center

On your desktop CoPilot Live tracks the location of the driver. Double-clicking
the vehicle in the Vehicle List will center the map on the driver's last reported
location. The vehicle location updates at an interval specified by the driver on his
Pocket PC (see Pocket PC Set Up, above) as long as both you and the driver are
running CoPilot Live.

Under Tools > Live tap the
Messenger tab. From here you can
toggle messaging on or off and specify
how often data is transferred.

Depending on the plan offered by your
wireless data service provider, sending
less data at infrequent intervals will be
more cost-effective.

Tapping on the Login tab will give you
the ability to change your screen name
as it appears on the home/office PC.
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Send/Receive Messages - Desktop

To send a message to the driver, click the Send Message button on the toolbar.
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Click your cursor in the space just below the Standard Response Buttons,
and begin typing.

The Standard Response Buttons are included in every message and are described
in detail in Receive/Respond To Messages - Pocket PC (p. 67).

You have complete control over the Customizable Response Buttons:

1) Choose to display 1-4 buttons by clicking the corresponding number at
the bottom of the screen.

2) Change the text of each button - the driver will see whatever text you
enter and when the driver responds, the text of the button will be sent
back to you.

Once you have typed your message and specified your Customizable Response
Buttons, click the Send button to send your message to the driver.

When the driver responds to your message, the response is displayed in the
Message Center:

Advanced:

Clicking on the Advanced tab of the Send Message window will expand the
view. From the Advanced view you can save frequently used message text and
button layouts that you can recall for future messages.
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Standard Response
Buttons

Text to Send

Send Button

Customizable
Response Buttons

Changes Number of Customizable
Response Buttons

Message and Driver’s Response
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Receive/Respond To Messages - Pocket PC Send Trip Itinerary Updates - Desktop
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When you are the driver and a message is sent to you, CoPilot Live displays it
on top of all other windows. If you have CoPilot Live's text-to-speech engine
installed, when a message is received you will hear the text of the message 
spoken out loud.

On the top are the four Standard Response Buttons which appear on every 
message:

Speak Message: CoPilot Live's text-to-speech engine
speaks the text of the message

Defer Message: Defers the message, which will reappear
later. Useful when you need to concentrate
on the turn instructions and the road.

More Information: Sends a response back that you need
more information.

Delete Message: Deletes the message-notice of the delete
is sent back.

You can also tap one of the Customizable Response Buttons at the bottom of the
screen that the message sender has included. The text on the button is sent
back.

To send a Trip Itinerary Update to the driver, click the New Trip button on the 
toolbar and create a trip itinerary in the Trip Planner window just as you would
in Planning Mode (see p. 58).

Then click the Send button:

In the Send Trip Confirmation window you can specify whether you want the
new trip itinerary to replace the driver's existing trip, add as the next stop(s) in
the driver's current itinerary, or add as the last stop(s) in the driver's current 
itinerary. Click OK to send the trip itinerary.

NOTE: CoPilot Live always uses the driver's current location as the start point
for giving route guidance.

Trip Planner Window

Send Button

Send Trip
Confirmation
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When the driver responds to your trip itinerary update, the response is displayed
in the Message Center:

Receive Trip Itinerary Updates - Pocket PC
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Send Trip and Driver’s Response

When you are the driver and a Trip Itinerary Update is sent to you, CoPilot Live
displays it on top of all other windows. If you have CoPilot Live's text-to-speech
engine installed, you will hear the itinerary updates spoken out loud.

The four Standard Response Buttons appear (see p. 67 for more details on these
buttons).

You can Accept or Decline the change to your trip itinerary. If you accept the
change, CoPilot Live will automatically start giving route guidance using the new
itinerary.
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Helpful Hints

Installation

Your Product Key Code can be found on the cover of your printed Quick Start.

One-Touch Access to CoPilot

You can program one of the buttons on your Pocket PC for one-touch 
access to CoPilot Live. Select Settings from the Start menu, click the
Buttons icon, highlight the button you would like to program by clicking 
on it, and select CoPilot Live from the drop-down Button assignment: menu.
In future uses pressing the assigned button will immediately launch CoPilot.

GPS Tracks

1. CoPilot Live will automatically track your trips, and save them as .gps files
which you can play back at any time to review a route. You can save memory
space by emptying this folder occasionally and transferring the files to a folder 
on your desktop PC that is not synchronized with your mobile device.
To do this connect your Pocket PC to your desktop, select Explore
from the drop-down File menu in ActiveSync, go into the GPS Tracks folder,
and transfer these files to another folder on your hard drive.

1a.These files are also helpful to us. Occasionally, please take these files,
Zip them, and send them to ccptrax@alk.com. Or, open CoPilot on your 
desktop PC while your Pocket PC is connected and select E-mail tracks to Club
CoPilot from the GPS menu. Using your GPS tracks, we will be able to enhance
the street-level system to provide even more accurate map data with each new
release.

About GPS Technology
The Global Positioning System (GPS), developed by the U.S. Department 
of Defense, is a constellation of 24 satellites that orbit the Earth twice daily.
Each satellite contains an atomic clock that is accurate to the nanosecond, and
constantly emitting radio waves toward Earth. GPS sensors (hardware devices
for receiving data) can receive these signals from the satellites, and using their
own internal clock can calculate the amount of time it has taken for the signal to
be received. GPS relies on the fact that radio waves travel at the speed of light
to calculate distances, and the exact location of the sensor is figured by 
combining the data received from four satellites. Using the data from these 
four satellites, GPS is able to give you the latitude, longitude and elevation of
your present location, and also your road speed and direction of travel on a
route. Given the right conditions, a GPS sensor can identify your geographic
position anywhere in the world within a matter of a few meters.

How CoPilot Live Uses GPS

CoPilot Live uses the GPS positional data that it receives from the hardware unit
you place on your dashboard to display your current position on a map as you
drive. This is called "tracking". CoPilot also uses the GPS data it receives to
guide you along your planned route, provided you enter a destination on your
Pocket PC. CoPilot Live guides you with audible prompts as you drive as well as
on-screen directions.

Tracking will begin automatically when you have satellite reception. In order to
get route guidance you have to enter a destination on your Pocket PC. Tracking
may also be used without receiving guidance instructions when you’re in
Navigating Mode. In this case, you'll see your trip tracked on the map on your
Pocket PC as you drive, but you won't see a highlighted route on the map and
you won't be given driving directions.

GPS Accuracy

The GPS signal CoPilot Live receives from the constellation of satellites 
has a rated accuracy of within 5 - 10 meters. This means that 95% of the time
the reported location is within 15 - 30 feet of your exact position. CoPilot takes
this location information and enhances it further by "snapping" it to our street
and highway network. Occasionally, CoPilot will place you on the wrong road. If
this occurs, keep driving and CoPilot will automatically correct itself and find your
proper position.

At times, CoPilot Live's GPS tracking will be less accurate or fail to work at all
because the unit is unable to receive satellite signals. Heavy foliage, tall buildings,
or any other structures obstructing communications will interfere with CoPilot's
ability to track your location. Like your car radio, GPS tracking can also be 
affected by weather conditions if severe. CoPilot Live will continue tracking as
soon as adequate signals are available. Despite these limitations, you can expect
CoPilot Live to provide you with useable and accurate information most of the
time. CoPilot Live will alert you if accurate information is unavailable.
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Trouble-shooting 

WWhhyy ccaann''tt II ggeett aa ssaatteelllliittee rreeaaddiinngg tthhee ffiirrsstt ttiimmee II uussee PPoocckkeett CCooPPiilloott??

The first time the GPS receiver is used it may take approximately 5 minutes to
acquire a signal (but may take as long as 15 minutes). You can minimize this time
by remaining stationary and positioning the GPS receiver so that it has a clear
view of the southern sky. Once initialized, the unit should acquire satellite signals
in 40 seconds or less in the future.

HHooww ccaann II ssppeeeedd uupp ssaatteelllliittee aaccqquuiissiittiioonn?? 

Be sure that the GPS receiver has an unobstructed view of the sky. Trees, build-
ings, and other obstacles are capable of blocking the satellite signals.

IInn tthhee ddrriivvee ssccrreeeenn oonn mmyy PPoocckkeett PPCC II aamm rreecceeiivviinngg ttuurrnn-bbyy-ttuurrnn iinnssttrruuccttiioonnss iinn tthhee bbllaacckk
bbooxx,, bbuutt mmyy CCooPPiilloott LLiivvee iiss nnoott ssppeeaakkiinngg.. WWhhyy iiss tthhaatt??

CoPilot Live provides voice prompts each time you come up on your next turn.
In order to hear these prompts you need to be sure the volume on your Pocket
PC is turned all the way up. On the Pocket PC in the Start menu go to Settings,
and click on Sounds & Reminders. Under System volume move the slide bar all the
way to the right.

You can also use your Pocket PC’s keypad to adjust the volume. Tap up to
increase the volume, tap down to decrease it.

GPS PROBLEMS

If you do not get a GPS signal please check the following:

1. Under GPS make sure there is a check mark next to 
Receiving.

2. If not please tap on receiving to check it on. If you can 
not place a check mark next to receiving by tapping on it 
please hit the Reset button located on the bottom or back 
of your Pocket PC while our program is open and the GPS unit 
is connected.

3. Once you hit the reset button open the program again 
and make sure there is a check mark next to Receiving.
Your GPS unit should now acquire a satellite fix.

Using Help Files
CoPilot Live provides extensive Help Files, available on your desktop/laptop and
your Pocket PC, to guide you through the program as you use it.

To access Help on your Pocket PC, once the CoPilot Live application is launched,
tap the Tools pop-up menu at the bottom of the screen and select Help.

Click on the Help button in any window in the desktop application to open a
Help topic that describes how to use that window. For example, if you're 
entering a stop in the Trip Planner window, the Help button will open Help at the
topic Entering Additional Stops. From there, you can navigate through other topics,
or do a search on a topic using the Search tab.

Another way to access the Help Files on your desktop is through the Help menu.
Contents and Search will open Help at the Table of Contents, which displays the
main topics available. Topic Search opens the Search tab.

Technical Support
After registering your software, you're entitled to technical support and 
discounts on future updates. There are three ways you can access technical
support for CoPilot Live:

� Check out our Internet site at http://www.alk.com/cp4 for technical
support documentation and posted answers to common questions.

� Phone support is available at 888-872-8768, Monday-Friday, 9:00 am-5:00
pm EST. Please be at your computer when you call and have your Product
Key Code handy. This code can be found on the front cover of the printed
Quick Start that came with your CoPilot Live package.

� E-mail us at techsupport@alk.com. Please include your Product Key
Code in the message (see the front cover of the printed Quick Start that
came with your CoPilot Live package).
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